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‘ﬁ' Quantitative Imaging Tutorial

Quantitative imaging is the extraction of
quantitative measurements from
medical imaging.

This tutorial is built upon two examples
of quantitative imaging:

- Morphology: small volumetric
changes in slow growing tumors

- Function: metabolic activity in
squamous cell carcinoma

©2011 Surgical Planning Laboratory, ARR Slide 2



®

Quantitative Imaging: Software

Powerful processing. Streamlined interface. Extensible platform.

B 3D Slicer

www.slicer.org

This hands-on tutorial will guide you
step-by-step through the use of
quantitative imaging modules of the
3DSlicer software.

3DSlicer is a freely available open-

source platform for medical imaging
research supported by the National

Institutes of Health.
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‘ﬁ' Tutorial Overview

Part 1: Basics of 3D Data Loading and
interactive visualization in 3DSlicer

Part 2: Measurement of small Volumetric
Changes in meningioma using the Change
Tracker module

Part 3. Measurement Metabolic Activity in
squamous cell carcinoma using the PET
Standard Uptake Value Computation module
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Introduction to the
3DSlicer software

Sonia Pujol, PhD

Director of Training,
National Alliance for Medical Image Computing
Brigham and Women’s Hospital, Boston, MA
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3DSlicer

®

Powerful processing. Streamlined interface. 1 Extensible platform.

3DSlicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3DSlicer is a multi-institutional effort
supported by the National Institute of

£ 3DSlicer ..., ...  Health

o~
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®

3DSlicer

Powerful processing. Streamlined interface.  Extensible platform. ° 3DSI|Cer ve rS|0n 42 |S a mu|t|-
Ao e [ platform software running on
Windows, Linux, and Mac OSX

» Slicer is distributed under a
BSD license with no restriction
on use

« Slicer is a tool for research,
and is not FDA approved

Disclaimer _ _
It is the responsibility of the user of 3DSlicer to comply with both the terms of the license and with

the applicable laws, regulations and rules.
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An interdisciplinary platform

An open-source environment for An end-user application for
software developers clinical investigators and scientists

A software platform that is both easy to use
for clinical researchers and easy to
extend for programmers
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‘ﬁb 3DSlicer History

« 1997: Slicer started as a
research project between the
Surgical Planning Lab (Harvard)

and the CSAIL (MIT)

Image Courtesy of the CSAIL, MIT
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3DSlicer History

1997: Slicer started as a
research project between
the Surgical Planning Lab
(Harvard) and the CSAIL
(MIT)

2012: Multi-institution effort
to share the latest advances
In image analysis with
clinicians and scientists
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NA-MIC Wiki

General

Center Components
»Algorith
» 1

Resources

A multi-institution: NA-MIC, NAC, NCIGT

National Alliance for Medical Image Computing

A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

Modeling the path of the tamping iron through the Gage skull and its effects on white matter

structure Read more.
. .

el -

B/

The National Alllance for Medical Image Computing (NA-MIC) is a
multi-institutional, interdisciplinary team of computer scientists, software
engineers, and medical investigators who develop computational tools for
the analysis and visualization of medical image data. The purpose of the
Center is to provide the infrastructure and environment for the development
of computational algorthms and open-source technologies. and then
oversee the training and dissemination ~**=~=
research community.

10f 24 Photos

Supported by the National Institutes of

Information about collaborating with NA

xsNa2012 4

The 96th Annual
Meeting of the
Radiological Society of
North America will be
held on November
25-30, 2012 at
McCormick Place, in
Chicago, IL RSNA s an
international society of
radiologists, medical
physicists and other
medical professionals
with more than 50,000
members across the
globe

ORead more.

ONEWS ARCHIVE

Neuroimage Analysis Center

About the NAC

Resources

Pl: Ron Kikinis, M.D.

[l Prodicted {
B Actua i

The Neuroimage Analysis Center (NAC) develops image processing and analysis techniques for
basic and clinical neurosciences. The NAC research approach emphasizes both speciic core
technologles and collaborative appiication projects. The activities of the NAC are centered at the
Harvard Medical School and the Surgical Planning Laboratory at the Brigham and Women's

). with collaborators throughout the United States and the rest of the world

for research center supported by the National Center for Research Resources
r 2011) and the Institute of Blomedical Imaging and Bioengineering (NIBIB)
© National Institutes of Health

I

DYy S ¢

\\?“‘CE"Q;,
% National Center for Image-Guided Therapy
o GI'5
%,
"Ilmac
NCIGT Wiki
About Us
» Overview

» Research Labs
> Research Cores

Research
Projects

» DBPs
» People

Resources

» Publication DB

» Image Gallery

» Downloads

» AMIGO

> News and Events
» Contact Us

Advanced Multimodality Image Guided Operating (AMIGO) Suite
The Advanced Mulnmodallly Image Guided Operanng (AMIGO) Sulte is an innovative

surgical and i thatis the clinical testbed of the
National Center for Inage-Guided Therapy (NCIGT) at the Brigham and Women's
Hospital (BWH) and Harvard Medical School. The AMIGO is an integrated, 5,700 square
foot area divided into three sterile procedure rooms in which a multidisciplinary team will
treat patients with the benefit of intra-operative imaging using multiple modalities. More.

© Featured Image Archive

The National Center for Image Guided Therapy (NCIGT) is a Biomedical
Technology Resource Center supported by the NCRR and NIBIB institutes

Pls: Ferenc Jolesz, M.D.,
Clare Tempany, M.D.
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Slicer: Behind the scenes

. —— Slicer is built every

This Is running the bleeding edge swn trunk CDash code, and is updated frequently. Yo

s e e night on Windows,

- [
Windows7-VS2010-320its-QT4.7.1-PythonQt-With-Tel-CLI-

B e Mac and Linux
SnowlLeopard-g++4.2.1-64bits-QT4.7-PythonQt-With-Tck-CL-

factory-mac-64bits. kitware R )

Linux-ge+4.4.3-64bits-QT4.7-PythonQt-With-Tcl-CLI-Release

factory-ubuntu-64bits. kitware )

@
135

platforms

Windows7-VS2008-64bits-QT4.7.1-PythonQt-With-Tel-CUI-
factory-win7 kaware % 100073
fa 7 3aware S, QT4.7.1-PythonQe- TekCU-

Release ¥«

Buidd Name Build Time

& SnowLeopard-geed.2.1-Qt4.7.0-PythonQt-With-Tck-Release
@

11 hours ago
youplsclutah.edu ’mcm.a.o«mnm-wm-rm~ FEe
ers aware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release 3 hours ago

r~—y ’L:Xwg.mn.vmmuwu-vwmm 11 hours ago
ke ans S Nbeare Linuxg++4.4.3-64bit3-QT4.7-PyhonQt-With-Tcl-NoCLI- 11 hours ago

Coverage-Reloase ‘A
Linux-g++4.3.3-QT4.7-PythonQt-With-Tc-NoCLI-Release

sagarmatha. kitware

Buid Name

OpenSuse-c++4.5.0-64dits-QT4.6.3-PythonQt. -NoCLI-
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* Hands-on training
workshops at national
and international
venues

 More than 2,000
clinicians, clinical
researchers and

' scientists trained
RENAZT since 2005
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Slicer Downloads

®

Q Slicer 4 download statistics

3DSlicer

) Download location By Country By Filename By Month
Total matching

downloads:

46794 [ [ S |

: ¢ a“iﬁ

Date r: : g : ® V%,

ate range ) - ; 1 ! o "«'J;Wﬁk(.

past year :] : 58 3 : his - /) 3
Release type:
[ any ¢]
Browser type:
[ desktop ¢]

Update

ANTARCTICA
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Part I:
3D Data Loading and
Visualization

Sonia Pujol, PhD
Wendy Plesniak, PhD
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ﬁ' 3D Data Loading and Visualization

* This tutorial is a short introduction to the
advanced 3D visualization capabilities
Slicer

» The Slicer4 Minute dataset is composed of an
MR scan of the brain and 3D surface
reconstructions of anatomical structures.

* The data are part of the SPL-PNL Brain Atlas
developed by Talos, Jakab, Kikinis et al. The
atlas is available at:

http://www.spl.harvard.edu/publications/item/view/2037
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Welcome to Slicer4

800 30 Slcer 42.0-c1:2012:10-28

File Edit View Help
£a Modules: . | Welcome to Slicer =00 9O e« 2« EE

@ 30Slicer

Welcome

[ Load DICOM Data | [sec Load Data )

[ = Slicer || @D Sample Data |

» About

®

CER

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

»
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Slicer4 Minute Tutorial: Navigating the Application GUI

The Graphic User
Interface (GUI) of Slicer4
integrates four
components:

* the Menu Toolbar

* the Module GUI Panel
* the 3D Viewer

* the Slice Viewer

c- oo v -Menu &:Toolbar

# Customize Slicer

cccccccccccccc

Panel

3D Viewer

©2011 Surgical Planning Laboratory, ARR

Slide 18



Welcome to Slicer4.2

800

ACPC

File Edit View Help

Add Scalar Volumes

ga &a [Modules: . | Welcome to Slicer Affine R_gimﬁun
All Modules @ Annotations

@ Annotations

308l
& o

% DICOM

Welcon- e

© Models
# Scene Views

i Load DICOM Data | -
( & Slicer | view C
@ Volume Rendering

DAbout @ Volumes

» The Main Window ___|® to Slcer
e Wizards
» Loading and Saving 1zards
» Display Registration
" Segmentation
» Mouse & Keyboard Qi ificati
e Diffusion
» Documentation & Tutorials|
e B C1
» Acknowledgment Filtering
| Surface Models
Converters
Endoscopy
Utilities
Developer Tools
Legacy
Testing

Work in Progress

AtlasTests
BSpline Deformable Registration
BSpline to deformation field
w Cameras
Cast Scalar Volume
ChangeTracker
Charting
CheckerBoard Filter
= Colors
Create a DICOM Series
@ Crop Volume
Curvature Anisotropic Diffusion
4 Data
DataProbe
Demon Registration (BRAINS)
& DICOM
DICOM to NRRD Converter
Diffusion Tensor Scalar Measurements
Diffusion Weighted Volume Masking
DTlexport
DTlimport
DWI Joint Rician LMMSE Filter
DWI Rician LMMSE Filter
DWI to DTI Estimation
DWI to Full Brain Tractography
DWI Unbiased Non Local Means Filter
Editor
EMSegment Command-line
L] with Atlas

N

& EMSegmenter without Atlas

©2011 Surgical Planning Laboratory, ARR
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Histogram Matching

Image Label Combine

Intensity Difference Change Detection (FAST)
Label Map Smoothing

Label Statistics

labelToggleBug2049

Linear Registration

Mask Scalar Volume

Median Image Filter

Merge Models

Model Maker

Model To Label Map

Models

Multiply Scalar Volumes
MultiVolumeExplorer
MultiVolumelmporter

N4ITK MRI Bias correction
OpenlGTLinkIF

Orient Scalar Volume

Otsu Threshold Image Filter

Otsu Threshold Segmentation
Performance Tests

PET Standard Uptake Value Computation
Probe Volume With Model

Reformat

Resample DTI Volume

Resample Image (BRAINS)
Resample Scalar Volume

Resample Scalar/Vector/DWI Volume
Rigid Registration

Robust Multiresolution Affine Registration
Robust Statistics Segmenter
RSNA2012Quant

RSNA2012Vis

egmentation

eding
Seeding
New EMSegmenter Standard

“ Transforms
Vector Demon Registration (BRAINS)
Vector to Scalar Volume
M View Controllers
ViewControllers Slice Interpolation Bug 1926
@ Volume Rendering
@ Volumes
Voting Binary Hole Filling Image Filter
‘WebGL Export
2 Welcome to Slicer
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ACPC Transform General Registration (BRAINS)

Add Images. Gradient Anisotropic Diffusion

: Annotations Grayscale Fill Hole

BSpline to deformation field Grayscale Grind Peak

Cameras Grayscale Model Maker

Cast Image Histogram Matching

ChangeTracker Image Label Combine

CheckerBoard Filter Intensity Difference Change Detection (FAST)
Colors Joint Rician LMMSE Image Filter

Create a DICOM Series Label Map Smoothing
Crop Volume Label Statistics
Curvature Anisotropic Diffusion Linear registration
DICOM MR Bias Field Correction

DWI to Full Brain Tractography Mask Image

Mask from Diffussion Waishtad Images

‘ommand-iine

i EMSegmenter with Atlas

& EMSegmenter without Atlas

Editor

Endoscopy

Event Broker

Execution Model Tour

Expert Automated Registration

Extract Skeleton

Fast Affine registration

Fast Nonrigid BSpline registration
on

oh

ng (BRAINS)

ime With Model (Paint)

Resampl
Resample Scalar Volume

Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Statistics Segmentation
putation

« Scene Views
Simple 10 Test
Simple region growing

Tractography Labelmap See:

Transform MRML Files o N

Transforms

Unbiased Non
View Controllers

© Volume Rendering

@ Volumes g

Voting Binary Hole Filling »

Welcome 1o Slicer

EMSegmenter Standard i

Al Means filter for DWI

Slicer4.2 contains
more than 100
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data
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Slicer4 Minute Tutorial: Welcome Module

——
File Edit View Help

# @& Modules: . &Welcome to Slicer =009 e ~ t - B A R,
BN
{5 cccccc
The SlicerWelcome  »m¢

DM Data 5 Load Data

mOdU|e iS the mOdU|e ?SIicer © Download Sample Data
displayed by default.

bw

iving

This module gives an =
overview of the GUI of
Slicer4, and data

loading & saving
functionalities.

oy
-

~ Data Probe

L
E

B
None RAS: (125.0, -125.0, 1.0),
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Slicerd Minute Tutorial: Load a Scene

Fle Edit View Help
ga &a |Modules: B\ Welcome to Slicer D ‘). PO &«a4d 2 % t.v fa S,
ox [E1E

Click on the Load Datalcon and select
Choose File(s) to Add and browse to the
directory ‘C:\Pujol2012’

Select the subdirectory
‘Quantitativelmaging _Sunday_Nov25 2012’

Select the directory dataset1_MR-Head and
click on Open
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Slicer4 Minute Tutorial: Load a Scene

3D Slicer 4.2.1

Ele Edit View Help

£a [Modules: -, @ Welcome to Siicer DR ENS ]

@ 3DSlicer
Welcome

[5isa, Load DICOM Data | [gac Load Data

L@ R R | 4~

Q@ a2 5
1

4 Customize Slicer ] @ Download Sample Data

Add data into the scene

Choose Directory to Add|(Choose File(s) to Add
» The Main Window v

» About

Show Options

File Description

» Loading and Saving

» Display

» Mouse & Keyboard

8no Open
Look in: (& Usersispujoliworksh...012/dataset1_ MR-Head (¢ | @ © @ @ (I [E]

_ A spujol Name

Select the file MRHead_Scene.mrml
and click on Open

» Documentation & Tutorials

» Acknowledgment

M optic_tract_Lvtk

optic_nerve_R.vtk

optic_nerve_L.vik
tic_chiasm.vik

lead_Scene.mrml
% Master Scene View.png

M left_eyeball vik

M hemispheric_white_matter.vtk
M grayscale nrrd

Il

File pame: |MRHead_Scene.mrml

Files of type: All Files (*)

v Data Probe

@
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Slicer4 Minute Tutorial: Load a Scene

3D Slicer 4.2.1

Eile Edit View Help
ga @ |Modules: =, @ Welcome to Siicer ™ O0Q PO «d 2 » t. v A e | 4 v

CEl *

3DSlicer

Welcome

( [y Load DICOM Data o) Load Data
( # Customize Slicer @ Download Sample Data
_ 806 Add data into the scene

» About

Choose Directory to Add|(Choose File(s) to Add Show Options
» The Main Window P E File Description

TUsers/spujoliworkshop/20T2/RSNAZ0T2- ML Soog <

» Loading and Saving 4 ROt loer-Data, RENA20T2/Quantiativelmaging_Sunday_Nov25_2012/dataseti_MR- | MRML Scene ¢

Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

Click on OK to load the data to Slicer

~ Data Probe
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Slicer4 Minute Tutorial: Viewing the Scene

Welcome

0090 @d « B L8 W A4~
e x HE

When the scene is finished loading,
Slicer displays:

*a 3D model of the head in the 3D
Viewer, and

*anatomical MR slices of the
brain in the 2D Slice Viewers.

kkkk
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Slicer4 Minute Tutorial: Exploring Slicer’ s functionality

0no | ACPC Transform Linear Registration i
File Edit View Help | Add Scalar Volumes Mask Scalar Volume
& |Moduies: -, [\ Weloome to Sicer Em e Regs xz;’g‘:wjz: Fiter
AtlasTests Model Maker
@ Annotations BSpline Deformable Registration Model To Label Map
3DSlicer 4 Data BSpline to deformation field
£ DICOM @ Cameras Multiply Scalar Volumes
 Editor Cast Scalar Volume MultiVolumeExplorer
We | C O r © Models ChangeTracker MultiVolumelmporter
R Scane Views Chartipg N4ITK MRI Bias correction
|4 Transforms . Egzcrze'am'd Filter * 8:::[“;1::‘;)‘“8
Losd DICOM BY E Vew ‘(;D:nggﬂer;ng Create a DICOM Series Otsu Threshold Image Filter
. @ Crop Volume Otsu Threshold Segmentation
j‘ Volumes Curvature Anisotropic Diffusion Performance Tests
|2\ Welcome to Slicer 4 Data PET Standard Uptake Value Computation
O a CceSS th e M Od e I s | Drichallenge .| DataProbe Prabe Volume With Model
S Wizads ,|  Demon Registration (BRAINS) @ Reformat
—— | Informatics »| & DICOM RegAladin
~ | Registration »|  DICOM to NRRD Converter Resample DTI Volume
m o u e rOWS e | Segmentation »  Diffusion Tensor Scalar Measurements Resample Image (BRAINS)
b} Quantification »|  Diffusion Weighted Volume Masking Resample Scalar Volume
| Diffusion »|  DTIChallengeExplorer Resample Scalar/Vector/DWI Volume
- IGT »  DTlexport Rigid Registration
ro u th e I I St Of Fitering »|  DTlimport Robust Muliresolution Affine Registration
s | Surface Models »  DWI Joint Rician LMMSE Filter Robust Statistics Segmenter
1 Converters »|  DWIRician LMMSE Fiter RSNA2012ProstateDemo
| Endoscopy »|  DWIto DTI Estimation RSNA2012Quant
l I I O u eS Utiities »|  DWIto Full Brain Tractography RSNA2012Vis
mE= Developer Tools »|  DWI Unbiased Non Local Means Filter & Sample Data
Legacy »| 2 Editor Scene Import (Issue 2428)
Testing »|  EMSegment Command-ine sa Scene Views
Work in Progress | i EMSegmenter with Atlas SelfTests
‘" without Atlas Simple Region Growing Segmentation
. Endoscopy SiiceLinkLogic
Event Broker SiiceraMinute
or click on the
e
Expert Automated Registration Subtract Scalar Volumes
Extract Skeleton Threshold Scalar Volume
fiber_visibility_crash2438 Tractography Display

models icon ; e Taciogaghy Iasiis Seedng
Foreground masking (BRAINS) Tractography Label Map Seeding

Gaussian Blur Image Filter Transform MRML Files to New EMSegmenter Standard

] General Registration (BRAINS) 4% Transforms
I n t e too I ba r Gradient Anisotropic Diffusion Vector Demon Registration (BRAINS)
Grayscale Fill Hole Image Filter Vector to Scalar Volume
Grayscale Grind Peak Image Fier I View Controllers
Grayscale Model Maker ViewControllers Siice Interpolation Bug 1926
Histogram Matching ® Volume Rendering
Image Label Combine @ Volumes
L Intensity Difference Change Detection (FAST) Voting Binary Hole Filing Image Filter
3 Label Map Smoothing WebGL Export
Label Statistics B\ Welcome to Slicer
labelToggleBug2049
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Slicer4 Minute Tutorial: Switching to the Models Module

e @MW/

®

3D Shicer 4.0.gamma-2ZUL1-11-14
& & |Modules: . [@ Models = Q0O I ® @ & §HE <

ex [l
@ 3DSlicer

| » Help & Acknowledgement 1|
= Scene

= hemispheric_white_matter.vtk 1.00
» left_eyeball.vtk B 100
» optic_chiasm.vtk 1.00
» optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
» optic_tract_R.vtk 1.00
= right_eyeball.vtk B 1.00
» Skin.vtk 1.00
= skull_bone.vtk 1.00

| Information

|~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:

v

|~ Data Probe

wmrr



Slicer4 Minute Tutorial: Basic 3D Interaction

®

e @ W) 3D Slicer 4.Uu.gamma-ZULl1-11-14

& % [Modules: . [@ Models = 0O IO @« &4 §HE 2 [F‘ 4 v Persistent Ao R | 4

@ 3DSlicer
v

| » Help & Acknowledgement

- Scene
B V) 4 1.00
Position the mouse - 1;§§
in the 3D Viewer. 1;§§
ot
1.00

Hold down the left

mouse button and
drag to rotate the

model.

wmrr




Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @MW 3D Slicer 4.u.gamma-<Zull-11-14

@ & |Modules: . [@ Models = QOO @ A @ E 2 @ 4 v Persistent | [@ fa Ho | 4 v
1 — R

e®
\@ 3DSlicer
4

|» Help & Acknowledgement E|

= Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk

Click on the Slice Visibility
o icon

||
Somaaaaalis
88888888&8

to display the Axial Slice in
the 3D Viewer

wmr
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Slicer4 Minute Tutorial: 3D Visualization

Slicer adds a view of
the Axial slice in the
3D View.
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Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @ W) 3D Slicer 4.U.gamma-2ZUL1-11-14
@ & |Modules: . [@ Models = 0O I ® @& &4 @ @ @ t - Persistent | @ Ra Ra | 4
e [l
O [® i |Adal 2 EB %, -
\@ 3DSlicer | & ‘—,‘ s ﬁ‘
. x| | B |None B
[» Help & Acknowledgement H — =
l [ cl | ,@I grayscale 3|
= Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk [ |

Click on the layout menu in
the toolbar, and select the
Conventional layout R

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v

|
85555385555

|~ Data Probe

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

®

Select the Skin.vtk 7 . - e
Change the opacity of the model from (S 2© & *9 4 & o - - &« -

1.0 to C.0.

» Help & Acknowledgement =
1.00
B 100
1.00
1.00
1.00
1.00
1.00
M 100
1.00
r
¥ Display
Visible: v (l
Selected:
Clip:
Slice Intersection: ibl
W Matasialnes,
Zolor:
dpacity: _— ‘1.00 B
\mbient: (000 2] [
v cohe |
L
F
B

©2011 Surgical Planning Laboratory, ARR Slide 32



Slicer4 Minute Tutorial: 3D Visualization

®

The model of the skull bone . _ .. . o..eu. @it
and eyeballs become visible " [
through the model of the skinin

the 3D viewer.

(skin model opacity = 0.5) -

Clip:

Slice Intersections Visible:
v Material Properties

Color:

Ambient: |00 (3] |~
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Slicer4 Minute Tutorial: 3D Visualization

®

The model of the skin becomes
invisible in the 3D viewer.[[0.0 ©© & & @& < B et~ =8 & &

(skin model opacity = 0.0)
(skull model opacity = 1.0)

# skull_bone.vtk

» Information ‘

¥ Display
Visible: v
Selected:

Clip:
S ections Visible:

s ersections
¥ Material Properties

Color:

Opacity: (000 %]
Ambient: B [oo 4 =
¥ Data Probs

L

£
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Slicer4 Minute Tutorial: 3D Visualization

®

Click on the Slice

Visibility
icon in the Green Slice
Viewer A

to display the Coronal
Slice in the 3D Viewer.

» Information

¥ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color: O

Opadity:
Ambient:
¥ Data Probe

L
E
B

©2011 Surgical Planning Laboratory, ARR Slide 35



Slicer4 Minute Tutorial: 3D Visualization

. | B i)
The Axial and Coronal | 7 B —

. . . | :-,0,\) DO s AP Hd ‘O‘t' Persistent H";h. v
Slices are displayed in | -<p:
the 3D Viewer. B

T
0
@
I
5
n

999999399
o o

Slice Intersections Visible:
¥ Material Properties

Color:

Opadity: _ ‘ 0.00 Ii:

Ambient: === It
¥ Data Probe

L

F

B
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Slicer4 Minute Tutorial: 3D Visualization

Select the 3D model skull_bone.vtk in - — —
the Model Hierarchy and turn on the I & b v st | @ A R |+~

Clipping option.

=} Scene
 hemisy ic_white_matter. v 1.00
® left_e B 100
* optic, v 1.00
> o Vi 1.00
= o v 1.00
& optic_tract_L.vi 1.00
® optic_tract_R.vi 1.00
® right_eyeball.v M 100
- Skin.v 0.00
>
» Information |
¥ Display |
Visible: v
Selected
H Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opacity: | 100 |5
Ambient: 000 %
¥ Data Probe
L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

B rOWS e th ro u g h 8.0.gamma-2011-11-14

w Help

the coronal Moddes: | @Models & - Q- QMO @ 4§ L | 4 v persistent fa Re,

slices to expose  fs
the 3D model of === -

] emispheric_white_matter.vtk 1.00
_eyeball.v! B 100
y Vi 1.00
pti re_L.vi 1.00
ptic_nerve_R.vi 1.00
ic_tract_L.vi 1.00
and the left an
_eyeball.v B 100
kin. v 0.00
. h t t. wil bonevi |
right optic n |
nerves. v
Clip: v
Slice Intersectior bl
¥ Material Properti
Color:
Opadity: 1.00 ‘:
Ambient: 0.00 : v
¥ Data Probe
L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

| S

Now make the skull ?.°/2© ® ¢ ®@ < @ ot~ w8 5 -
invisible.

"= Scene
# hemispheric_white_matter.vtk 1.00
# |eft_eyeball.vtk B 100
# optic_chiasm.vtk 1.00
® optic_nerve_L.vtk 1.00
 optic_nerve_R.vtk 1.00
 optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
L+ skin.vtk 0.00
» Information |
v Display |
Visible:
Selected:
Clip: v

Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: _— ‘1,00 2

Ambient: i=——————————— [T l—: -
¥ Data Probe

L

F

B
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Slicer4 Minute Tutorial: 3D Visualization

®

Scroll the Coronal Slices to display the

(2] E ]

hemispheric white matter model in the[,>.0 = © &+ © 2 - & ¢ t- = & « -

1

context of the image data in the 3D
Viewer.

[ |
7 35
W2
i - /.‘ 4
3 S
1bf
U

N\
X A ¢
- A (h F —
1.00 - S e
1.00 %
.00 - —
1.00
M 100
0.00
0.00
¥ Display |
Visible: v
Selected:
Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opadity: 0.00 %
Ambient: 0‘00% b
¥ Data Probe
L
F
B

e v
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Slicer4 Minute Tutorial: 3D Visualization

Select the hemispheric white matter model called
hemispheric_white _matter.vtk

Turn off its visibility.

= Scene
L] - ® he 100 |
* e B 100
> 1.00;
ol 1.00;
> 1.00;
- 1.00
- 100
- B 100
> 0.00
# skull_bone.vtk 0.00
» Information
¥ Display
H Visible:
Selected:
Clip:
Slice I ection: bl
¥ Material Properties
Color:
Opacity: 1.00 |4
Ambient: 0.00 (51 (v
¥ Data Probe
L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

|

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.

®
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Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

®

File Edit View Help

/£ 3D Slicer 40.gamma-2011-11-14 ==
92 B | Modues: @ Models s - G. IO & A G 2 | 4 v persistent R So, -

Windows/Linux users: Position the
mouse in the 3D Viewer, hold down
the right mouse button and move| ..

the mouse down to zoom in.

puC_woTt L
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
® Skin.vtk

Mac users: Position the mouse in|
the 3D Viewer, hold down the apple
button and the mouse button and

move the mouse down to zoom in_

(or use two fingers on the touch™ " -
pad).

E
B
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®

Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

@ 3D Slicer 40.gamma-2011-11-14

O | B |3

File Edit View Help

‘;\“"‘Iﬂ" 5 Modues:

@ 3DSlicer

@ Models

:_vG_J QQ%KX@E/ ;t‘ Perststent}.:bghv

» Help & Acknowledgement

Slicer displays a closerfz:====
view of 3D anatomicali= "
structures overlaid on 2D

MR slices:

Visible:
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color:

Opadity: | 1.00 :
Ambient: 0.00 (51 [+
¥ Data Probe

L

E

B

v
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®

Close the existing scene and all its data

Select File->Close
Scene

This removes any dataset
previously loaded into Slicer.

Select File-> Exit to exit the

software

2 3D Slicer 4.0.gamma-2011-11-14

& I :ne e ?OdEIS i _, 0, {D QD @ A W Z P &t 4 v [ persistent =% g@v -
Download Sample Data ®®

= AddData Ctrl+A

@ Add Volume

(2] Add Transform

th Save
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Part I: Summary

This first part of the tutorial has demonstrated:

» Basic description of the Slicer4 Application Interface
 How to load a scene containing volumes and models
« How to visualize these different datasets together

Next, we will use these building blocks to perform image
analysis and visualize quantitative results.
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Part ll: Analyzing Small
Volumetric Changes

Sonia Pujol, PhD
Kilian M Pohl, PhD
Andriy Fedorov, PhD
Ender Konukoglu, PhD
Ron Kikinis, MD
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‘ﬁ' Conventional measures of tumor response

Conventional anatomic imaging using
CT or MRI are often used to evaluate
tumor size and shape

Most clinical trials that evaluate new
chemotherapeutic drugs use changes
in uni-dimensional or bi-dimensional
measurements to assess response
(e.g. RECIST)

Slicer has several tools for applying
RECIST methodologies
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Slide 48



Conventional measures of tumor response

®

File Edit View Help
&a |Modules: @A
Y soslicer
1>
» Help & A
vvvvv
B @ & @ @
A (none) 3
ck | Edit | Val Descrif
PO
FEN

& & s 320 di
& & s 320

2 s
& L

3D Slicer Annotations
module can be used to
measure diameters in a
tumor cross section, and
to provide interactive
numerical annotations.
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®

Clinical case: baseline scan

Baseline radiologist’ s
clinical impression:

* large falcine lesion is
identified.

* measures 3.10 cm
anteroposteriorly and 3.51 cm
in height.

* enhances moderately on
post gadolinium imaging.

©2011 Surgical Planning Laboratory, ARR

Slide 50



Clinical Case: follow-up scan

Follow-up radiologist’ s clinical
impression:

* |left frontal lobe mass appears
unchanged on all series.

* measures 3.3 x3.2cmin
maximum dimension.

* enhances moderately on post
gadolinium imaging.
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Clinical Case: follow-up scan

Follow-up radiologist’ s clinical
impression:

* |left frontal lobe mass appears
unchanged on all series.

* measures 3.3 x3.2cmin
maximum dimension.

* enhances moderately on post
gadolinium imaging.

- How has the tumor changed?

©2011 Surgical Planning Laboratory, ARR
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‘ﬁ' ChangeTracker: rationale for new approaches

More accurate and precise methods for understanding volume
changes may be useful when:

benign tumor change is being monitored, or

where small changes may be clinically significant but
difficult to assess with RECIST
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Goal of the tutorial

MR Scan1 June 2006 . . : .
The following section will guide

you step-by-step through the
computation of small volumetric
changes in a slow growing tumor.

MR Scan2 June ZOOZM
This tutorial is built upon two

scans (Axial 3D SPGR T1 post
Gadolinium) of a patient with
meningioma, and uses the
Change Tracker module of Slicer.

(Voxel dimension: 0.94mm x 0.94mm x
1.20mm, FOV: 240mm, Matrix: 256 x 256)
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ChangeTracker: Load the dataset

Select File> Add Data in the main menu

& Customize Slicer & Download Sample Data

» About Choose Directory to Add|Choose File(s) to Add

» The Main Window File

» Loading and Saving

Select the directory
dataset2_ChangeTracker located in
C:\Pujol2012\Quantitativelmaging_Sunday Nov25 2012

Select the scene file: ChangeTrackerScene.mrml and click
on Open

Click on OK to load the data to Slicer

©2011 Surgical Planning Laboratory, ARR

File Edit View Help
Ba & & Modules: 2\ Welcome to Slicer s = PO e«Z 2 3R Ao fa
ex 1
L <

N

\

\\

\

|
Show Options ‘

Description

|

?sers/spuju\/ .._ChangeTracker O @ @ E]
3 v Size |k
§-spgr.nrrd 4.B n
f-spgr.nrrd 5..B n
ngeTrackerScene.mrml 20KB n
ter Scene View.png 3.B p
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Load g the data

Vi
ga & |Modules: . i Welcome to Sicer

Welcome
The datasets of the e —
ChangeTrackerScene
appear in the anatomical
viewers.

~ Data Probe

wnr
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ChangeTracker: exploring small volumetric changes

®

3D Slicer 4.2.0

g |Modules: 2\ Welcome to Slicer "0 Q0|9 O @ @ z Bt~ Ao o -
All Modules

@ Annotations
4 Data

7 Scene Views
% Transforms
® View Controllers

Using the Modules Menu « wrerees

@ Volumes

(@ Load DICOM Data |

1™ Welcame to Slicer

button, select the —
ChangeTracker Module o=, ’

Quantification

in the Wizards category. o

Converters
Endoscopy

Utilities
Developer Tools
Legacy
Testing

Work in Progress

~ Data Probe

L
F
B
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ChangeTracker: a note about the Workflow wizard

@ 3DSlicer
w

» Help & Acknowledgement

®

The WO rkfl OW Wiza rd S P I ¥ 1. Selectinput scans
g u id eS th e u Se r th ro u g h a te p a n e - Select the baseline and follow-up scans to be compared.
sequence of steps and has I Load et ot

the following components: | User Panel-- || sz [secs ome

Followup scan: ‘ Select a Volume

O O

* the Step Panel
* the User Panel
* the Navigation Panel

Navigation
Panel-- I

o 5) I

¥ Data Probe ‘
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Step1: Select input scans

File

®

Im

dit View Help
]

Modules: . [ChangeTracker " Q> 9O e«@ 2 Bt~ o R
ox R
Q sosticer

» Help & Acknowledgement

A
\
1n ha ramnarad ) ’ }

_ Click tol expand the tab ‘“1.Select input scans’
" - Set the Baseline scan to 2006-spgr1
- Set the Follow up scan to 2007-spgr1

~ 1. Select input scans
lont cali

Followup scan: 2007-spgr1
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Step2: Define Region of interest

®

800

File Edit View Help

& Modules: . |ChangeTracker =090 «d 2 Bt~ Ao R
o®

@ s0Slicer

» Help & Acknowledgement

~ 2. Define Region of Interest
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI

A Volume of Interest (VOI) =~

Box Widget appears in the =
anatomical viewers, and in
the 3D viewer.

~ Data Probe

@
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®

Step2: Define Region of interest

Browse through the Axial

Sagittal and Coronal slice
viewers to get a close-up
view of the tumor

Zoom in (Right mouse
down and push/pull).

Pan (Middle mouse down
and move)

@

les: ChangeTracker = QPO ad 2 Bt~ R S
>
N
gement /

'\
if Interest . ‘\
rs the object of interest. /f \

4 \
tionROI " |
10.00
=@
10.00
e—0
10.00
e—0
Clipping box v Interactive Mode
L
=Y *
)
|
)
-~
K i

1
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Step2: Define Region of interest

800 3D Slicer 4.2.0
File Edit View Help
ga £ Modules: . |ChangeTracker dm Q0> 9O e«@ 2 Bt~ o S v
ox R
[B) sosiicer
e

» Help & Acknowledgement

C he VOI fi

-
enter the irst:
~ 2. Define Region of Interest
Define ROI that covers the object of interest.
Select ROI: AnnotationROI
Define VOI

L-R Range:(.10.00 10.00

=8
P-ARange: (17 47 37.47

Position the square in the

_— center of the tumor in the
"= | Display Clipping box «;;;cliveMode Slice Viewer.

I-S Range: (1g.44

€]

~ Data Probe

[5)

Yellow RAS:(-1.9,-43.1,6.2) Sagittal Sp: 0.9
L None 0
F 2007-spgr1 (130, 173, 70) 105
B2006-spgr1 (130, 173, 60) 87
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Step2: Define Region of interest

®00 2

File Edit View Help

ga &a |Modules: . [ChangeTracker "m0 PO @@ 2 Hlt- )=
o= R

@ 30Slicer

S:24.72 1

» Help & Acknowledgement

~ 2. Define Region of Interest
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI
Define VOI

L-R Range: (21 49 5 15.94

o

P-A Range: (10,94 45.71
——0
I-S Range: g 23 47.77
——0

Next, resize the VOI:

Use the colored handles

o
3 Display Clipping IT « Interactive Mode

to change the VOI extent |

B
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Step2: Define Region of interest

8 00
File Edit View Help

ga £a 'Modules: . [ChangeTracker

"m0 QPO e«ad 2 HIt-EB W 5
el :24.72 % 1
B o

» Help & Acknowledgement

~ 2. Define Region of Interest

The VOI box and \ -
volume rendering of ‘ >0

tumor in yellow appear in :
the 3D Viewer

~ Data Probe

W
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Step2: Define Region of interest

800
File Edit View Help
ga £ Modules:

Q s0slicer

. |ChangeTracker

0P e«d 2 Bt B =
el

» Help & Acknowledgement

2. Define Region of Interest
Define ROI that covers the object of interest.
Select ROI:| AnnotationROI
Define VOI
L-R Hangs:‘_2°.67 [a]

1446 3] -

P-ARange:[1094 | 4505 |2~
I-S Range: g .23 4777 3~

\; Display Clipping box ¥ Interactive Mode

Fine-tune the VOI using
the VOI Widget range

sliders or by moving the

VOI Widget handles in
\ 3D view

~ Data Probe

~ Note: VOIWidget range sl

- W

iders are color-coded to
match VOI box Widget handles in 3D Viewer
©2011 Surgical Planning Laboratory, ARR
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®

Step2: Define Region of interest

e00

3D Slicer 4.2.0

File Edit View Help
£ 'Modules:

Select the viewing mode
‘Conventional Widescreen’

ChangeTracker

PO e«d s B t-8 W+~

Conventional
[E@ Conventional Quantitative
Four-Up
[ Four-Up Quantitative
Dual 3D
& Triple 3D
3D only
[ Red slice only
[ Yellow slice only

Define VOI
L-R Range:(.20 g0 B 15.45 2 -
. G——
P-A Range: g g s 44.49 2
c e——0
I-8 Range: (g g0 : 46.66 [ -
e——=0

3 Display Clipping box ¥ Interactive Mode

€]

~ Data Probe

o W

[ Green slice only

[E Tabbed 3D

Tabbed slice

E Compare »
[M Compare Widescreen »
M Compare Grid »
[ Three over three

o [ Three Over Three Quantitative
[ Four over four

[ Two over Two
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®

Step2: Define Region of interest

eo0o 3D Slicer 4.2.0

File Edit View Help

ga & |Modules: . [ChangeTracker A" QO PO @@ 2 tv @ A R b
1

o8
@ 3DSlicer
v
» Help & Acknowledgement
~ 2. Define Region of Interest
Define ROI that covers the object of interest.
Select ROI:| AnnotationROI :
Define VOI
L-RRange: 2090 2 1545 [z~
P-A Range: (g oo O] (44.49 :‘ - -
J— - —
I-S Range: 9,90 5 (4666 3] -
\W Display Clipping box ¥ Interactive Mode

Slicer shows a closer
view of the volume
rendered tumor region.

(€] I )

~ Data Probe ~_
| Red RAS:(-110.7,28.3,21.9) Axial Sp: 1.4
L None 0
F 2007-spgr1 (246, 97, 83) 0
B2006-spgr1 (246, 97, 71) 0
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Step2: Define Region of interest

®

eo0o0 3D Slicer 4.2.0
File Edit View Help
ga &a |Modules: . [ChangeTracker

" Q00190 e«d 2 t-E W

» Help & Ackr

~ 2. Define Region of Interest

Define ROI that covers the object of interest.

Select ROI:| AnnotationROI
Define VOI
L-R Range:‘_zo_go B

[1545 12
P-ARange:fggo | (4429 2]
IS Range: (9,90 [4666 2]

"= | Display Clipping box ¥ Interactive Mode

Zoom in and out, and
rotate the volume
rendered image to
explore the tumor §
region in 3D. Lo

al Sp: 1.4

L None
F 2007-spgr1 (246, 97, 83) 0
B 2006-spgr1 (246, 97, 71) 0
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Step2: Define Region of interest

®

©00
File Edit View Help

&3 Modules: . [ChangeTracker

» Help & Acknowledgement

~ 2. Define Region of Interest
Define ROI that covers the object of interest.

Select ROI:| AnnotationROI
Define VOI
L-R Range:| .o gn

Select ‘Four-Up
Quantitative’ to return
to the initial view mode

e—0
ing box v Interactive Mode

Q )

~ Data Probe

L
F
B
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Step3: Segment the tumor

®

e 00
File Edit View Help

ga &a Modules: . |ChangeTracker 5 PO «d <~ HI It~ A S
# 1.00 ;| & baselineROI_segmentation

B sSlicer
@ |5+]0.00 %/ g& None

Click on the piniicon inthe top | o=
left corner of the red slicer
viewer to display the names of
the two volumes that Slicer has
generated automatically:
baselineROI and
baselineROIl_segmentation

~ Data Probe

wmr
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Step3: Segment the tumor

®

e00
File Edit View Help

£o 38 %o IMadulae: o [ChannaTrankar = Q. VO «d <~ Bt~ fo Fa,
‘baselineROI ‘(background |~ = eseEe”
viewer) is the subvolume that | . s

corresponds to the previous
VOI
‘baselineROIl_segmentation’
(labelmap viewer) is the
current segmentation of the
tumor.

== [he 3D Viewer
shows the

corresponding 3D
model of tumor

In the current settings, Slicer
displays the segmentation
overlaid on the spgr volume
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N Step3: Segment the tumor

000
File Edit View Help

@ Modules: ChangeTracker

< v|Axal s |EE o @3 W
» Help & Acknowledgement

TTITE fSelect the layout FourUp in the

# 1.00 ;| & baselineROI_segmentation
@ |5+]0.00 %/ & None
B | &

layout menu to display the

3. Segment the analyzed structure

Segment the structure in the selected ROI.
~ Basic settings
> Choose threshold:| 188 |

» Advanced settings

volume rendered segmentation

W?@g“
k{g‘\’i’g Aj‘!’ l,.{)
b ,;,1-

>

Modify the segmentation of the

tumor by moving the threshold
range slider

)
~ Data Probe

L
F
B
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Step3: Segment the tumor

800
File Edit View Help

&3 |Modules: . |ChangeTracker

®

= Q0O PO @« « HIt-E w5
e iR

Scroll through
the slices until the e

Segmentation ::;er:i::;dnzo: G G 3
appears optimal.

vanced settings

Click on the green
C ° arrow to move to the
next step

~ Data Probe

o W
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Step4: Select the Analysis Method

®

8 00

File Edit View Help

&a |Modules: . [ChangeTracker = QOO «ad « Bt~ o Fa
ec R

@ 3DSlicer

» Help & Acknowledgement

~ 4. ROI Analysis
Select the analysis method for the selected ROI.

~ Basic settings
Intensity Difference Change Detection (FAST)

» Advanced settings

Select the ROI Analysis Method :
‘Intensity Difference Change Detection (FAST)’

Y

S— ° Click on the green arrow
\ to move to the next step

wnr
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Final Step: Change Tracker Results

@00
File Edit View Help
& |Modules:

ChangeTracker

» Help & Acknowledgement

~ 5. ROl Analysis Results

[ntensityDifferenceMetric |
Growth: 1.69 mL (16423 pixels), or 1.08%
Shrinkage: 0.00 mL (0 pixels), or 0.00%
Total: 1.69 mL (16423 pixels), or 1.08%

Left click on the slice menu to display the volumes that have been
generated:

- followupROI correspond to the subvolume that has been extracted
around the tumor in the 2007-spgr_1 dataset

- changesVolume_IntensityDifferenceMetric corresponds to the
change between the 2006 and 2007 scans
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Final Step: Change Tracker Results

800
File Edit View Help

ga £ 'Modules: . |ChangeTracker d=QQIgeea@ 2 Bt~ Ao o, & F
ox R

The change in volume is shown |
overlaying the tumor image and |
in the 3D Viewer: |
magenta = growth
green = shrinkage

o W
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Visualization of the change in pathology

®

The results of the analysis are
displayed in the “Compare View”
layout

*Six consecutive slices for the VOI
in Scan1 (top row), and

*Six corresponding consecutive

slices for the VOI in Scan2 (bottom
row).

*A zoomed view of the axial slice in
the red slicer viewer
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Visualization of the change in pathology

The Crosshairs in Compare View show corresponding
voxels in Scan1 and Scan2 for voxel-wise comparison.
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Change Tracker Results

®

600 3D Slicer 4.2.0
Edil View Help
5 Add Data %A ngeTracker I QO0I9O @ < HIt-B w n|+f
£ DICOM i || %]
®
& Download Sample Data
% Save ®Ss 4
Recently Loaded > S/
= Close Scene KW ‘ (N
Exit ! " ‘
I ———————— £
] Ak
~
piasenyDifferenceMetric ]
Growth: 1.69 mL (16423 pixels), or 1.08% r
Shrinkage: 0.00 mL (0 pixels), or 0.00% e

Total: 1.69 mL (16423 pixels), or 1.08%
X

\ > Ll o - Axal ¢ baseneRO rscsun7]

+ | followupROI

./m
="

@
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‘ﬁ' Change Tracker module

This tutorial demonstrated the use of the change tracker module in
Slicer on axial 3D SPGR T1 post Gadolinium scans

» Tumor boundary should be clear
> Only for contrast enhanced images
» Need homogenous enhancement across timepoints.

« The Change Tracker module has not been tested for tumors with
changing necrosis.
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ChangeTracker: Exploring small volumetric changes

®

This tutorial demonstrated:

» a method to quantify small volumetric changes in pathology.
» visualization of these changes in the anatomical context

» use of Slicer’s “Compare Viewer” to simultaneously explore
baseline and followup studies.

Next, we will demonstrate combined visualization of
PET/CT studies and SUV computation.
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Clear the scene and its data

#A hgeTracker DRk Q_ QPO &« @ 2 E t v @ A =Y (% F
| CE]

1423 pixels), or 1.08%

Clear the previous scene. oses oo

3 pixels), or 1.08%

Select File->Close Scene

This removes any datasets

previously loaded into Slicer.

Select File> Exit to restart
Slicer
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PET/CT Visualization and Analysis

Part lll: PET/CT
Analysis

Sonia Pujol, PhD

Kitt Shaffer, MD, PhD
Hatsuho Mamata, MD, PhD
Ron Kikinis, MD
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‘ﬁ' Goal of the tutorial

The goal of this tutorial is to
guide you step-by-step
through the SUV
computation of PETCT data
of a squamous cell
carcinoma case pre- and
post- treatment
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ﬁ) FDG-PET SUV

« Standardized Uptake Value (SUV) is a semi-quantitative measure
derived from the determination of tissue activity obtained from a
clinical PET study

SUV = Tissue Concentration of Radioactive Tracer x
Patient Weight / Injected Dose

« Under certain circumstances, 18-F Fluorodeoxyglucose (FDG)
SUV correlates with metabolic rate of glucose and/or the number of
viable tumor cells
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‘ﬁ' Tutorial Case

Pathology: poorly differentiated
squamous cell carcinoma

Treatment: radiotherapy and
chemotherapy (weekly cis-platin)

Two 18F-FDG PET and CT scans
acquired within a 5-month interval.
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‘ﬁ' PETCT tutorial: Clinical Case and Data

The datasets are located in

C:\Pujol2012\QuantitativelmagingSunday Nov25 2012
\dataset3 PETCT

- PETCT1 dataset is located in the pre-treatment
directory corresponds to the baseline

- PETCT2 dataset is located in the post-treatment
directory corresponds to the follow-up scan.
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Select DICOM Database Directory

File Edit View Help
g Modules: . | &Welcome to Slicer =009 e s t- o Fa | v

> ~ o
.0 Click on Load DICOM Data in

© Download Sample D.

the panel of the Welcome to

» Loading and Saving

Slicer module

» Mouse & Keyboard

nnnnn Load DICOM Data
omize Slice

» Documentation & Tutorials ‘ ‘

» Acknowledgment

~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Select DICOM Database Directory

File Edit View Help

ile Ec
g Modules: . @#DICOM

Q sosticer

» Help & Acknowledgement

~ Servers
Start Listener
Start Listener when Slicer Starts
~ DICOM Database and Networking

r 800 DICOM Details
Import Export Query Send Remove LocalDat:#/Users/spujol/data/DICOM-database
/N Name ~ Age Scan Date Subject | Number Institutiol Referrer Performer

Lmeee MIAARA Dameimme

The DICOM Details

window appears

DICOM Data Reader Warnings

Refresh

Uncheck All Load Selection to Slicer Close
Make DICOM Browser Persistent

< D

~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Select DICOM Database Directory

The window Select DICOM Database Directory appears
when you use the DICOM module for the first time

Browse to the directory:
C:\Pujol2012\Quantitativelmaging_Sunday Nov25 2012

Select the sub-directory dicom-database

Click on Choose

©2011 Surgical Planning Laboratory, ARR Slide 90



‘ﬁ' Select DICOM Database Directory

Slicer’s local DICOM database is now set to:

C:/Pujol2012/Quantitativelmaging_Sunday Nov25 2012/
dicom-database
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oading a DICOM Volume (Mac Users)

‘000 3D Slicer 4.2.1

File Edit View Help

ga & & |Modules: . [#DICOM Q0 QIO €@ 2 R |EI VB A R4~

ex E

@ 3DSlicer S
[» Help & Acknowledgement > r— e —
[ o
[~ Servers Import  Export  Query Send Remove((  LocalDatabe| 9 /Users/spujol/workshop/tmp ]

[ Start Listener Name ~ Age Scan Date SUbJecte-Number | Institution | Referrer _Performe

Start Listener when Slicer Starts
[~ DICOM Database and Networking
( Show DICOM Browser
[~ Recent DICOM Activity
0 series added to database in the past hour 000
<« > 88 1= ) | (] 3DSlicer-Data_RSNA2012 m
v DEVICES
B ok > Quantit
& aloha » (i 3DVisualization_Tuesday_Nov27_2012
4 Macintosh HD

v SHARED
belkin n+

» PLACES

» SEARCH FOR

Refresh
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oading a DICOM Volume (Mac Users

3D Slicer 4.2.1

File Edit View Help
ga 2 & Modues: « [#@DICOM ™ QO PO «@d 2 A t-| @ A Fo
1

h 3DSlicer
L4

» Help & Acknowledgement DICOM Detail
etails

v Servers Import  Export  Query d Remove LocalDatabe # /Users/spuijol/workshop/tmp
Start Listener
Start Listener when Slicer Starts
~ DICOM Database and Networking
Show DICOM Browser

~ Recent DICOM Activity

Name ~ |Age Scan Date Subject ID | Number Institution | Referrer Performer

0 series added to database in the past hour

Find Directory
m) (& Quantitativelmaging_Sunday_No... 4] Q
DEVICES Name 4| Date Modified Kind
£l ipisk » (1 datasetl_MR-Head 1novembre 2012 19331 Folder
H aloha » (1 dataset2_ChangeTracker 1 novembre 2012 19:29  Folder
icom-database novembre 23 Folder
Refresh

SHARED
(B9 belkin n+

PLACES

I SEARCH FOR
Select the directory dicom-database and
click on Choose

¥ Laia Frone

Ceme)

| Green RAS:(125.0, 1.0, -105.0) Coronal Sp: 1.0

L None()
F None()
BNone()
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Loading a DICOM Volume

—

30 Slcer 4.2.0

File Edit View Help

|83 & &a [Modules: . [%DICOM =00 190 «@ <« EIt-8 M hl+-

@®

G sosticer

» Help & Acknowledgement ~v DICOM Details

< Sorvers { import fxpot Query Send »LocalDatabalt bSlicerCourses_Nov25-27_f DSlicer-Data_| itati ing_Sunday_Nov25_:

( Start Listener \Name / Age Scan Date Institution | Referrer | Performer

Start Listener when Slicer Starts

~ DICOM Database and

( Show DICOM Browser

~ Recent DICOM Activity

0 series added to database in the past hour

= I DICOM Data | Reader | Warninas |

800 Import DICOM i )
Lookin: (G /RSNA2012/3.. ttati ing_Sunday_Nov25 2012 +|Q © @ @ () [E)
4 spuic| Name ~ Size  Kind Date Modified

Refresh

11/1/127:31 PM
11/1/12 7:29 PM
11/16/12 12:03 PM
11/16/12 12:08 PM
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Loading a DICOM Volume

File Edit View Help
T R —— X

e
\@ 3DSlicer

[» Help & Acknowledgement

3D Slicer 4.2.1

PO ed s t- @ M R4

[~ Servers
[ Start Listener 000 DICOM Details

Start Listener when Slicer Starts Import  » LocalDatabz)12/RSNA2012-Chicago/RSNA2012/3DSlicerCourses_Nov25-27_RSNA2012/3DSlicer-Data_RSNA2012/Que
|~ DICOM Database and Networking Name ~ Age Scan Date Subject ID |[Number |Institution |Referrer | Performer

[ Show DICOM Browser
[~ Recent DICOM Activity
0 series added to database in the past hour

000 Import DICOM files from directory ...
| Look in: £ /Users/spujol/...dataset3_PETCT | @ © @ ¢ () [E]) |
A spujol Name lings

~ (& post-treatment

Refresh

< I

Directory: | pre-treatment E Import

D
@ —F - - N
E iles of type:| Directories \ M
Copy on import

|~ Data Probe

Select the pre-treatment directory and click on Import
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Loading a DICOM Volume

3D Slicer 4.2.1

File Edit View Help
ga &3 |Modules: -, [#DICOM =0 ©

1
@ 3DSlicer
4

» Help & Acknowledgement

PO a2 R EI t-E @ R

8006 : DICOM Details
~ Servers | Import » LocalDatabeb12/RSNA2012—Cmcago/RSNA2012/3DSI\cerCourses,NovZS-ZLRSNAZO12/3DSI\cer-Data,RSNA2012/Oua
( Start Listener | Name ~ |Age Scan Date Subject ID |Number | Institution |Referrer | Performer
Start Listener when Slicer Starts
~ DICOM Database and Networking /\
[ Show DICOM Browser :

~ Recent DICOM Activity

2 series added to database in the past hour

Today: HEAD NECK_2D AC for
Today: SOFT for

DICOM Data Reader Warnings

Refresh

Uncheck All || Load Selection to Slicer
Make DICOM Browser Persistent

Click to expand the list of DICOM volumes accessible via the DICOM
browser
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Loading a DICOM Volume

Select the series PET Skull to MID Thigh Plus DCT Chest W Ini

@ soSticer

» Help & Acknowledgement

0.NoO

~ Servers i Import  » LocalDatabz)12/RSNA2012-Chicago/RSNA2012/3DSlicerCourses_Nov25-27_RSNA2012/3DSlicer-Data_RSNA2012/Qua

Start Listener || Name ~ | Age Scan Date Subject ID |Number |Institution |Referrer | Performer
Start Listener when Slicer Starts (E
= PET Skull to Mid Thigh Plus DCT Chest W Ini 2012-06-07
~ DICOM Database and Networking [ FT cT 3 2012-06-07 1
Show DICOM Browser i HEAD NECK_2D AC PT 401 2012-06-07 0

~ Recent DICOM Activity B

2 series added to database in the past hour

Today: HEAD NECK_2D AC for

Today: SOFT for

DICOM Data

Refresh

Slicer displays the list of DICOM volumes
located in the pre-treatment directory:

- ‘SOFT’ is the CT dataset

- ‘HEAD NECK_2D AC’ is the PET dataset
(note: this may take a few minutes)
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Loading a DICOM Volume

3D Slicer 4.2.1

File Edit View Help

Slicer displays a snapshot of the DICOM volumes: == —
- ‘SOFT’ is the CT dataset
- ‘HEAD NECK_2D AC’ is the PET dataset :

2 series added to database in the past

Today: HEAD NECK_2D AC for
Today: SOFT for

IEAD NECK_2D A( DICOM Data Reader Warnings E

v 3: SOFT Scalar Volume IA: 0,00
Refresh v 401: HEAD NECK_2D AC Scalar Volume
| 3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced ..
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced ..
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced ..
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced ..
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced ..
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced .. o
check All Load Selection to Slicer Close

<

— . OM Browser Persistent
— Click on Load

| Green RAS:(7.3,0.0,-6.5) Coronal Sp: 1.0

Line() Selection to Slicer

BNone()
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Loading a DICOM Volume

File Edit View Help K
% 2 Za |Modules: - [#DICOM = 0019 @ &« @ < t An Fe | 4+~
o [

B
\

ssssssssssss

The PET dataset appear in the anatomical viewer

Select the layout Conventional in the layout menu
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Loading a DICOM Volume

AN : v
Select the module Data in the modules menu
\ \ \

m_(_ Right click on the volume ‘3: SOFT and rename it CT1
Right click on the volume ‘401: HEAD NECK_2D AC’ and
rename it PET1

lelelele
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Loading a PETCT dataset

File Edit View Help
ga & |Modules: 4 Data

» Help & Acknowledgement

~ Display & Modify Scene

Left click on the pin icon in the top left corner
to display the red slice viewer menu.

The PET1 volume is currently displayed in the
Background viewer

Click on the links S icon to link all three
views together, and change the selected
volume to CT1
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Loading a PETCT dataset

File Edit View Help
& |Modules: @ Volumes

"m0 QIO @@ 2 Bt 8 w |4~
e@® — e ————

@ 30Slicer

» Help & Acknowledgement

Active Volume |CT1 $|
» Volume Information |

~ Display |
Lookup Table:|Grey

Interpolate: v
Window Level editor presets:

W:4918 |2 Auto W/L | L:-519 2
Threshold: /\ Off :
-3634 = 3680
»Histogam | | A

mmmm

Select the module Volumes and use the -
sliders in the Display tab to adjust the
Window and Level of the CT images

B _
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Visualization of PETCT data

®

000

3D Slicer 4.2.0
File Edit View Help
ga 25 & Modules: . @ Volumes = Q. GO e«d <~ Bt~ fa R, v
ey o JS:=Teadoy 1
4o ovAkal 2o P I W
B oo g
» Help & Acknowledgement B :; " : Ig;)_?e
> Active Volume|PETT : Pec ]
» Volume Information Refyme current Volume
~ Display

Lookup Table:| Grey

Interpolate: -
Window Level ¢

| | Set the Actlve Volume to PET1 and

W:34106 7| /

- Select the PET1 image in the

3411 &

background viewer

~ Data Probe

L
F
B
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Visualization of PETCT data

®

00 3D Slicer 4.2.0

File Edit View Help

& |Modules: . [@ Volumes = Q. PO e« 2 BE - fa R, .
or R

@ Slicer

» Help & Acknowledgement

Active Volume | PET1
» Volume Information

~ Display

>._ookup Table:| PET-Heat

Interpolate: v
Window Level editor presets:

Il @ a

W: 35061 2 |Manual W/L 4+ |L:17667 2

Threshold: Off :
B A — 32767 |2
» Histogram

~ Data Probe

! Select the Lookup table to PET-Heat

-

w
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Visualization of PETCT data

|
Choose Directory to Add| Choose File(s) to Add + Show Options ‘
File Description Options
he main m
the main menu - |
- Look in: (1/Users/spujol/.../pre-treatment ¢ (1) g@@
Select Choose File(s) to Do _rane ot
CTi ~F
P

£ PET1
3

Add and browse to the pre-
treatment directory

Select the file PET1-

label.nrrd and click on Open
to load it in Slicer
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Visualization of PETCT data

Vi
& |Modules: . [@ Volumes = Q. PO «d <~ Bt~ A R
@®

®

» Help & Acknowledgement

Active Volume PET1
» Volume Information

~ Display | n‘ )

Add data into the scene
Lookup Table:| PET-Heat Choose Directory to Add|[Choose File(s) to Add < Show Options
wzrd%%atzvel ;diior resets: ‘ e Descrption Options

P " Centered ' Ignore Orientation v/ LabelNA« Single File

) - -y = ¥ ...ETCT/pre- | Volume 4| PET1-label
L UES £

W: 35061 /2| Manual W/L +|/L: 17667

——

Threshold: Off
BN B — 32767

Check the ‘Show Options’ box,

and check that the option ‘Label

Map’ is selected.

Select the file PET1-label.nrrd
= gnd click on OK to load it in
Slicer

wnr
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Visualization of PETCT data

e00
File Edit View Help
&a |Modules: . [@ Volumes = Q. $oe«@ - H t- Ao Fa, -

1S:-168.

o e R —
@ <+ v|Axial LR - ]

®

Select the outline mode for ~—— s

@ | = .| B | PET1

the PET1-label segmentation
in the labelmap V|ewer

Wdle

i Dp@Ea

W: 35061 2 Manual W/L +||L: 17667 2

The outline of a lesion
appears in the anatomical

viewers

Threshold: Off :
B P — 32767 |

» Histogram

wnr
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®

Visualization of PETCT data

File

File Edit View Help
25 &3 Modules: . @ Volumes = Q. PO a«d s« HIt- Ra R,
ot 168.4¢
«| @ | 4+ v|Axial : - ]
_fs’\ Slicer # [1.00 |2/ & | PET1-label
————————— B «[[050 :[m@|cT!
» Help & Acknowledgement E e

@ e[” -|@|PET1

Active Volume PET1
» Volume Information

~ Display
Lookup Table: PET-Heat
Interpolate:

v \
Window Level editor presets: [/ RS / /

LS BT st the CT1 dataset in the foreground viewer,

" and change the opacity of the CT images to
0.50 to display the CT images overlaid on the

PET images

SSSA40.00

~ Data Probe

L
F
B
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Visualization of PETCT data

» Help & Acknowledgement

Active Volume PET1

Check on the slice visibility icon |~-| in the red
and yellow viewers to display the axial and

||||||||||||||
B N —— 32767 |2

~ Data Probe

L
F
B
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PET uptake findings

7?@77 @7 Modules: . | @ Volumes = Q. PO e« 2 Bt~ fn fo, -
R

Note an intense uptake in
1) left oropharyngeal mass
involving the base of tongue
and left glossotonsillar
fossa and,

2) in left level [IA/III lymph
nodes as well as a small
adjacent left level Ill node.
3) a possible small
metastasis in the left
retropharyngeal region at
level of C1
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PET SUV Computation

File Edit View Help
f@ @ Modules: PET Standard Uptake Value Computation '+ —:f\} VO % @ z 4~ w S

For the purpose of this

tutorial, we have pre-
segmented the lymph nodes
uptake region. In the next
section, we will compute the
SUV for this area.

Select the module PET
Standard Uptake Value
Computation in the
category Quantification in
the modules’ menu
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PET SUV Computation

000

3D Slicer 4.2.0

File Edit View Help

ga £ |Modules: . |PET Standard Uptake Value Computation |4 | =» Q) PO a@d 2 Bt~ e S v
ey il —

@ oslicer

» Help & Acknowledgement

~ PET Standard Uptake Value Computation
Parameter set: PET Standard Uptake Value Computation

Status Idle

~ Image and Information

Step1: Input volumes selection
Select Input PET Volume ‘PET?’

)

PET-BiCOMvolume patir ) TS
Input PET Volume PET1
Input VOI Volume PET1-label

oo

~ Output

Output (csv) file SIS S

Output Label
Output Label Value
SUV Max

SUV Mean

SUV Minimum

Default Cancel Apply

~ Data Probe
Red RAS: (63.4,-9.2,-168.5) Axial Sp: 3.3
L PET1-label (36, 84,63) 0 (0)

FCT1 (148, 325, 164) -995
BPET1 (36,84,63) 661.377441

Select Input VOI Volume ‘PET1-label’
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PET SUV Computation

File Edit View Help

oou) @ Modul PET Standard Uptake Value Computation
B zosiicer

4

» Help & Acknowledgement

~ PET Standard Uptake Value Computation

Parameter set:| PET Standard Uptake Value Computatig /%"=
Dropbox

Status

~ Image and Ir
PET DICOM volume path [ 9 /Application:
Input PET Volume PET1

Input VOI Volume PET1-label

Ly

3
[ |

~ Output

Output (csv) file
Output Label
Output Label Value
SUV Max

SUV Mean

SUV Minimum

Step2: Path to the DICOM PET header
Click on /Applications in the PET DICOM volume path, and select the PET1

subdirectory located under C:/Pujol2012/
Quantitativelmaging_Sunday Nov25 2012/dataset3 PETCT/pre-treatment/PET1

L
F
B
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PET SUV Computation

2 =0,

Vi
;@ ou) @ Modules: PET Standard Uptake Value Computation

SO < (Mt~

Ao Fa,

» Help & Acknowledgement

v PET Standard Uptake Value Computation
Parameter set:| PET Standard Uptake Value Computation
Status

Step3: SUV Computation ~
Click on Apply to compute

the SUV in the segmented
region

Default Cancel
~ Data Probe

o
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PET SUV Computation

eono 3D Slicer 4.2.0
File Edit View Help
@ Modules: PET Standard Uptake Value Computation '+ | ™ Q

9o «d <~ A

E 3DSlicer

» Help & Acknowledgement

v PET Standard Uptake Value Computation
Parameter set:| PET Standard Uptake Value Computation

Status

P777777777 7777777777777 T7I7
~ Image and Information

PET DICOM volume path | & /Users/spujol/workshop/RSNA201<

SUV Computation Results:

T e SUVmax = 7.53385 mg/m

Output (csv) file

v SUVmin = 5.01805 mg/ml
Output Label Value |1 L}

SUV Max 7.53385 - Y @ =

SUV Mean 5.01805

SUV Minimum 3.39015

SUVmean = 3.39015 mg/ml

Default Cancel | Apply
~ Data Probe

wnr

©2011 Surgical Planning Laboratory, ARR Slide 115



PET SUV Computation

000 3D Slicer 4.2.0
File Edit View Help
& |Modules: . |PET Standard Uptake Value Computation ¢ | ™» Q) PO e«d

ox R
@ >Slicer

» Help & Acknowledgement

v PET Standard Uptake Value Computation

Select File> Close Scene in the main menu

iy s

PET DICOM volume path & /Users/spujol/workshop/RSNA201<

Input PET Volume PET1

Input VOI Volume PET1-label
~ Output

Output (csv) file

Output Label 1

Output Label Value |1

SUV Max 7.53385

SUV Mean 5.01805

SUV Minimum 3.39015

Default Cancel | Apply
~ Data Probe

wnr
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Loading the post-treatment dataset

> o 1) Select the module DICOM, and click
B o on Show DICOM Browser

» Help & Acknowledgement

File Edit View Help
oo 88 8. aaooi

. [Z] None ’

~ Servers
Start Listener
Start Listener when Sicer Starts Import  » LocalDatabajworkshop/RSNA2012/3DSlicerCourses_Nov25-27_RSNA2012/3DSlicer-Data_RSNA2012/Quantitativelmaging_Sunday
DICOM d NetworKing

Name ~ Age Scan Date Subject ID  Number Institution  Referrer Performer

0 series added to database in the past hour
Past Week: HEAD NECK_2D AC for
Past Week: SOFT for

mmmmmmmmmmmmmmmmmmmmmmmmmmmmm

2) Click on Import and select the dataset post-treatment — —_—
located in the directory

C:/Pujol2012/
Quantitativelmaging_Sunday_Nov25 2012/
dataset3 PETCT/post-treatment/

B

©2011 Surgical Planning Laboratory, ARR Slide 117



oading the post-treatment dataset

File Edit View Help
ga 25 & Modules: . [#DICOM " Q09O «d 2 HBIt-E w R -

B Click to expand the DICOM files tree

» Help & Acknowledgement

[Z] None
~ Servers ‘ ‘
Start Listener P
Start Listener when Slicer Starts |
~ DICOM Database and Networking
Show DICOM Browser
~ Recent DICOM Activity |

2 series added to database in the past hour

Today: HEAD NECK_2D AC for
Today: SOFT for

Past Week: HEAD NECK_2D AC for
Past Week: SOFT for

DICOM Details

mport  » LocalDataba workshop/RSNA2012/3DSlicerCourses_Nov25-27_RSNA2012/3DSlicer-Data_ RSNA2012/Quantitativelmaging_Sunday

— me ~ Age Scan Date Subject ID  Number Institution ' Referrer Performer

NECK_ DICOM Data Reader Warnings =

v 3: SOFT Scalar Volume
Hefresh _ « 5: HEAD NECK_2D AC Scalar Volume
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of Scalar Volume  Images are not equally spaced
-3 SOFT for contantTima of 1 Sealar Vinlima. Imanas are not acuallv enacad =
. . Uncheck All Load Selection to Slicer Close
—_— Make DICOM Browser Persistent
~ Data Probe
L
F
B

Most recent DICOM Database addition: Sat Nov 17 21:15:01 2012

©2011 Surgical Planning Laboratory, ARR Slide 118



Loading the post-treatment dataset

3D Slicer 4.

File Edit View Help

ga 2 % Modules: . [#DICOM " QPO @@ 2 Bt B8 w k
e iR
Q 30Slicer
» Help & Acknowledgement
~ Servers
StartListener  __geioig DICOM Details
Start Listener when Slicer Starts Import  » LocalDataba workshop/RSNA2012/3DSlicerCourses_Nov25-27_RSNA2012/3DSlicer-Data_RSNA2012/Quantitativelmaging_Sunday
~ DICOM Database and Networking = ——
——| Name ~ Age Scan Date Subject ID  Number Institution | Referrer Performer
Show DICOM Browser | _
~ Recent DICOM Activi | F_’ET %lsull to Mid Tl f'llgs DCT Chest W Ini 12 6-
2 series added to database in the past hou? = SOFT CT 3 2012-11-06 1
Today: HEAD NECK_2D AG for = = HEAD NECK_2D AC PT 5 2012-11-06 0
Today: SOFT for
Past Week: HEAD NECK_2D AC for
Past Week: SOFT for
< >
NECK_ DICOM Data Reader Warnings =
v 3: SOFT Scalar Volume
Hefissh « 5: HEAD NECK_2D AC Scalar Volume

3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume  Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
3: SOFT for contentTime of 1... Scalar Volume Images are not equally spaced
2 SOFT for contantTime, of 1 Sealar Violuma _ Imanas ara not anualiv snacer =
. . Uncheck Al Close
Make DICOM Browser Persisté

Select the 2nd series PET SKULL-MID THIGH PL and click in Load
Selection to Slicer to load the follow-up PET and CT scans to Slicer
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Loading the post-treatment dataset

©00
File Edit View Help

£3 Modules: . [ 4 Data dm QO PO «d ~ Bt~ fa Fa, -
o R

S:-145.39 % 1

» Help & Acknowledgement

oo Select the module Data

i and rename the CT scan

— > Hwwe  ‘3:SOFT’ to CT2 and the
PET scan ‘6: HEAD
NECK 2D AC’ to PET2

Scene Model: | Transform
Display MRML ID's
Show Hidden nodes
Filter:
» MRML Node Inspector

» Load & Add Scenes Or Individual Datasets

~ Data Probe

L
F
B
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Loading the post-treatment dataset

800 3D Slicer 4.2.0
File Edit View Help
& |Modules: . |@ Volumes QO IPO @@ 2 Bt fa -

B >Slicer

» Help & Acknowledgement

Select the module Volumes

» Volume Information
- Discrete

oo g Select the Active Volume PET?2

Interpolate: Rainbow

Window Level Ocean

| e e € LOOKUp table to -Hfea

i InvertedGrey
ms'\:/(erseﬁainbov

o - |

W: 55106 3 MRIPA

p— Random

Threshold: Red
Green

-5511  [50= Blue

» Histogram Yellow
Cyan
Magenta
Warm1
Warm2
Warm3
Cool1
Cool2

Cool3
Randomintegers
= Shade

= Tint
« FreeSurfer
PET

; PET-Rainbow
PET-MaximumintensityProjection
= Cartilage MRI
« Default Labels from File
GenericAnatomyColors
GenericColors

~ Data Probe

wnr
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Loading the post-treatment dataset

File Edit View Help
ga & |Modules: . [@ Volumes = QO 9O «d « HIt- R R, -
oy i — CELEICRE
<& < vAxal s |EE o B F W
Q Slicer - = None : =
» Help & Acknowledgement @ [&2]0.00 g 22 =

N Acti
> Active Volume|CT2
» Volume Information

nnnnnnnn

Click on the links icon and set the CT2
volume in Foreground in the E - LR
anatomical viewers.

~ Data Probe

L
F
B
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Loading the post-treatment dataset

800
File Edit View Help

ga &a |Modules: . |@ Volumes

= QPO @@ 2 BIt-E M 4+~
ex [lR

» Help & Acknowledgement

Active Volume | CT2

» Volume Information
~ Display

Lookuy, pT able: Grey

Interpolate:

Window L el d
RilOp@Ea
W:2556 |7 |Manual W/L L2217
Thresha i ot =
4334 S 5680 S
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PET uptake findings
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larynx and pharynx that
are likely due to radiation
effect.
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PET uptake findings
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‘ﬁ' Conclusion

» This tutorial has demonstrated how to do 3D data
visualization, quantitative measurement of small changes in
tumor size, and PET CT SUV computation in Slicer

» 3DSlicer is for research use only, and is not FDA approved

« 3DSlicer is a free open-source software for medical image
computing and supported by the NIH
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3DSlicer at RSNA 2012

®

Hands-on courses:

* Tues. Nov.27, 12:30 pm -2 pm: 3DVisualization of DICOM images for
Radiological Applications. Sonia Pujol, PhD, Kitt Shaffer, MD, PhD, Ron
Kikinis, MD (SCD401)

« Wed. Nov. 28, 10:30 am — 12:00 pm: The NIH/NCI Cancer Imaging
Archive (TCIA): A Comprehensive Source of DICOM Imaging Data for
Research — Hands-on. C. Carl Jaffe MD, John B. Freymann BS, Justin
Kirby, Fred William Prior, PhD, Lawrence R. Tarbox PhD
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®

3DSlicer at RSNA 2012

Oral presentations:

* Mon. Nov. 26, 11:40-11:50: Computer-aided Diagnosis of Pure DCIS from
DCE-MRI: Quantitative Results in 19 Patients. Jayender Jagadeesan, PhD

* Mon. Nov 26, 02:30-04:00: Open Source Applications for Medical Imaging
Research (SCD401). Ricardo Avila, MS Wesley Turner PhD, Julien Finet
MSc
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®

3DSlicer at RSNA 2012

Quantitative Imaging Reading Room Exhibit QIRR 3007

» Sun. Nov 26-Fri. Nov 30, 8:00-6:00 3DSlicer: An Open Source
Platform for Segmentation, Registration, Quantitative Imaging,
and 3D Visualization of Multi-Modal Image Data.

Sonia Pujol, PhD, Steve Pieper, PhD, Andriy Fedorov, PhD,
Ron Kikinis, MD,
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®

3DSlicer at RSNA

Sunday, November 25 Monday, November 26

Tuesday, November 27

Wednesday, No ber 28

Friday, November 30

8:00am-11:00am. 3D Slicer
Exhibit &, Quantitative Imaging
Reading Room, Lakeside
Learning Center, Hall E, LL-
QRR3007

8
8:00am-11:00am. 3D Slicer | Ex
Exhibit &,, Quantitative Imaging
Reading Room, Lakeside

Learning Center, Hall E

:00am-11:00am. 3D Slicer 8

hibit &, titative | i . - .
R CERITED [HEEE Exhibit & Quantitative Imaging

Reading Room, Lakeside
Learning Center, Hall E

11:00am-12:30pm. RSNA
Refresher Course:
"Quantitative Medical
Imaging for Clinical
Research and Practice”
Katarzyna Macura, Sonia
Pujol, Ron Kikinis &. Room

12:15pm-1:15pm. Meet-The-
Experts Session &,
Quantitative Imaging Reading
Room, Lakeside Learning
Center, Hall E

Applications" Sonia Pujol,
Kitt Shaffer, Ron Kikinis &.

:00am-12:15pm. 3D Slicer

Reading Room, Lakeside
Learning Center, Hall E

12:30pm-2:00pm. RSNA
Refresher Course: "3D

Visualization of DICOM
images for Radiology

12:15pm-1:15pm. Meet-The-
Experts Session &, Quantitative

Imaging Reading Room,

Lakeside Learning Center, Hall

E

Room S401CD

S401CD -
1:15pm-6:00 pm. 3D Slicer

Exhibit &, Quantitative Imaging,

12:30pm-6:00 pm. 3D Slicer
Exhibit & Quantitative Imaging,
Lakeside Learning Center, Hall

E

Lakeside Learning Center, Hall||Exhibit &, Quantitative Imaging,
E Lakeside Learning Center, Hall

12:30pm-6:00 pm. 3D Slicer

1:15pm-6:00 pm. 3D Slicer
Exhibit &, Lakeside Learning
Center, Hall E

E

8:00am-12:15pm. 3D Slicer

Exhibit &, Quantitative Imaging

Reading Room, Lakeside
Learning Center, Hall E

12:15pm-1:15pm. Meet-The-

Imaging Reading Room,
Lakeside Learning Center, Hall
E

1:15pm-6:00pm. 3D Slicer
Exhibit &, Quantitative Imaging
Reading Room, Lakeside
Learning Center, Hall E

8:00am-12:45pm. 3D Slicer
Experts Session &, Quantitative||Exhibit &,, Quantitative Imaging

Reading Room, Lakeside
Learning Center, Hall E

Questions: spujol@bwh.harvard.edu
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